
Overview
Kaleidoscope is a collection of tools for the efficient processing of acoustic and 
ultrasonic recordings. Some of these tools are licensed separately. 

In a single batch operation, Kaleidoscope can perform several tasks in parallel: 

Convert audio file formats 
.wac Wildlife Acoustics compressed format 

.wav Waveform Audio File Format 

.??# AnaLookW zero crossing sequence file format 

Support for both time-expanded and normal speed files 

Support for breaking large files into smaller pieces 

Support for splitting multi-channel recordings into multiple single channel 
recordings 

Add field notes to meta data in output files 

Filter out files containing only "noise" 

Extract GPS tracks from metadata 

Automatic identification of files to species 

Generate files suitable for creating pivot table reports 

In addition, with Kaleidoscope Viewer, you can: 

View spectrograms by opening individual full spectrum or zero crossing files 

Add or edit meta data (e.g. field notes and manual classifications) to files 

Quickly review and manually verify automatic identifications 

Kaleidoscope retains most of its settings and writes them to a file "settings.ini" in the 
output directory. You can load a settings file or restore default settings from the "File" 
menu. 



File Conversion
Kaleidoscope can convert a batch of input files recorded in a variety of input formats to 
output files in a variety of output formats. This feature is available at no charge. 

File Types

.wac Wildlife Acoustics Compressed Format 

The .wac or Wildlife Acoustics Audio Compression format is a proprietary audio 
format produced by Song Meter and Echo Meter recorders. A .wac file may 
contain one or more channels (mono or stereo recordings), and these 
recordings may be either continuous or triggered. Triggered recordings are 
used for ultrasonic work (e.g. recording bats) where only periods of detected 
activity (a triggered event or "bat pass") are recorded. A triggered .wac file may 
contain several triggered events as they are detected independently on each 
channel. In addition to acoustic data, .wac files may contain GPS track 
information when created by GPS-enabled recorders. 

.wav Waveform Audio File Format 

The .wav format is a defacto standard developed by IBM and Microsoft for 
representing multi-channel audio recordings. There are several flavors of .wav 
file formats that may utilize different forms of audio compression and meta 
data. Kaleidoscope supports only uncompressed 8-bit and 16-bit Pulse Code 
Modulation (PCM) .wav files. Wildlife Acoustics has also defined a proprietary 
extension to the .wav file format to store metadata. 

Time Expanded Files: 

The .wav format described above may also represent time expanded recordings. 
Time expanded recordings are commonly used in ultrasonic work where the 
original recording is stretched through time by a constant factor effectively 
slowing it down such that ultrasonic signals are divided down into the audible 
range. This is accomplished by simply adjusting the sample rate of the 
recording. For example, if a recording is made at 384,000 samples per second, 
the sample rate in the file's metadata can be changed to 38,400 while keeping 
all the original audio samples. If we now play back this file at 38,400 samples 



per second, it will take ten times longer to play and the frequencies will have 
been divided down by a factor of ten times. Such a file would be said to have a 
time expansion factor of 10. 

.??# AnalookW Zero Crossing Sequence File Format 

The .??# format is a proprietary format used in legacy zero-crossing bat 
detectors developed in the early 1990s by Chris Corben for Titley Electronics. 
These are not "recordings" in the conventional sense in that the original analog 
signal was not digitized and saved like they are in .wac and .wav files. Instead, 
the time between a number (division ratio) of sequential zero crossings is stored 
in the file. The original signal can not be reconstructed from this small amount 
of data. However, with sufficient signal-to-noise ratio, the dominant frequency 
sweep through time produced by the echolocation calls of bats can be 
represented. 

Batch File Conversion

Choose the input files you wish to convert:

From the "Batch" tab on the Kaleidoscope main window, set the "INPUTS" parameters 
found on the left hand side of the window: 

1. Choose your "Input directory", a folder on your computer containing the input 
files you wish to convert. 

2. Check "Include subdirectories" if you want to convert files recursively in all the 
subfolders below the "Input directory" specified above. Otherwise only the files 
found in the "Input directory" will be converted and subfolders will be ignored. 

3. Check "WAC files" if you want to convert from .wac files. 
4. Check "WAV files" if you want to convert from .wav files. You must also select the 

"Time expansion factor" used by the input files. A factor of "1" should be used for 
normal speed files. If the input .wav file was created by a time expansion bat 
detector, the time expansion factor should be set to the time expansion factor 
used to make the recording. 

5. Check "ZC files" if you want to convert from .??# files. 

Choose the output formats you wish to convert to:



From the "Batch" tab on the Kaleidoscope main window, set the "OUTPUTS" parameters 
found on the right hand side of the window: 

1. Choose the output directory in which you want to write the output files. Note that 
this must not be under the input directory. If the input "Include subdirectories" is 
checked, output subfolders will be created mirroring the directory structure of the 
inputs. 

2. You can optionally have Kaleidoscope arrange outputs into daily or nightly 
subfolders (if Kaleidoscope can determine the recording timestamp from the 
input filenames or metadata) by choosing "Daily" or "Nightly" for "Create 
subdirectories" Otherwise, you can specify "None". 

3. If you would like Kaleidoscope to break up long files into multiple short files, you 
can specify a value for "Split to max duration", otherwise leave this field blank. 

4. Check "WAV files" if you wish to convert to .wav files. Check "Split channels" if 
you would like to separate each channel of a multi-channel input file into 
individual single-channel output files. If you want to output time expanded files, 
you can specify a time expansion factor. For normal time files, use a factor of "1". 

5. Check "ZC files" if you wish to convert to .??# files. You can specify the ":Division 
Ratio" to use. You can also check the "8.3 file names" to output files with the 
legacy 8.3 filename convention. 

Caveats

There are a number of important caveats to keep in mind: 

1. Converting from .??# zero crossing formats to .wav full spectrum formats is not 
possible to do accurately because zero crossing formats do not contain any 
amplitude or harmonic content information from the original recorded signal. 
Instead, Kaleidoscope uses sophisticated digital signal processing techniques to 
synthesize a full spectrum signal from the zero crossing data that simulates the 
frequency modulated signal through time, but with no harmonic structure and 
with uniform amplitude information. 

2. Converting from .??# to .??# produces a copy of the original file and does not 
actually change the division ratio or split the recording into smaller pieces. 

3. The .??# file format has a number of file size and duration limitations that are 
enforced. If converting from a longer .wav or .wac file, multiple .??# files may be 
produced to avoid exceeding these limits (15 second duration or 32KB filesize or 
16K zero crossing points). 



4. Converting from .wav or .wac full spectrum to .??# zero crossing may use 
Kaleidoscope's "Advanced signal enhancement" feature (recommended) which 
can be turned on or off from the "Filter" tab of the main Kaleidoscope window. 
When turned off, the full spectrum input is band-pass filtered according to the 
frequency range specified by the "Signal of interest" described in the "Filter" tab 
and the resulting signal is converted to zero crossing without further 
enhancement. When turned on, Kaleidoscope further enhances the signal with 
noise reduction and echo cancellation techniques prior to zero crossing, but also 
removes echoes and fragmented calls. The result is a cleaner filtered zero 
crossing output that may detect weak signals that would have been missed or 
fragmented using conventional zero crossing. On the other hand, some weaker or 
fragmented pulses remaining may be discarded. We recommend leaving this 
feature turned on, especially when using the automatic classification features. 

Running the batch

Press the "Process files" button to run your batch. A progress bar will display estimated 
time remaining. 

Keep in mind that Kaleidoscope may be performing other tasks in parallel with file 
conversion such as filtering, GPS track extraction and automatic classification. You 
should familiarize yourself with these features as they may affect the outputs. 

File Naming Conventions

The Song Meter line of products use the following naming convention: 

  Prefix_  YYYYMMDD_hhmmss . extension

A "Prefix" may be optionally specified in the Song Meter configuration (typically to keep 
track of files from different Song Meters with different prefixes). If present, the prefix is 
prepended to the filename with an underscore character between the prefix and the 
year. The extension is either "wav" for a WAV file, "wac" for a WAC file, or "00#" for a 
Zero crossing file. 

On the Echo Meter EM3, the file name convention is slightly different to accommodate 
an additional optional tag character (represented by "T" below). This may be included if 
one of the tag buttons (e.g. A, B, C, or D) is pressed during recording, or the special "N" 



tag used to mark potential noise files. If no tag is present and the file is not a noise file, 
then the tag character is an underscore. The file name looks like this: 

  Prefix_ T_YYYYMDD_hhmmss . extension

The output file name format will be in one of the following formats: 

  Prefix_   YYYYMMDD_hhmmss_mmm . extension
  Prefix_ T_YYYYMMDD_hhmmss_mmm . extension
  Prefix_ C_YYYYMMDD_hhmmss_mmm . extension

If an Echo Meter tag is specified, the second form is used with "T" representing the tag 

If splitting channels from stereo to two mono channels, the third form is used with "C" 
representing the channel number (0 = left, 1 = right). 

Otherwise the first form is used. In all these forms, an additional mmm is appended 
indicating the milliseconds offset. 

When converting files that are not in the Song Meter filename format, the original 
filename is preserved and appended with _C_sssss_mmm . extension. 



Filtering Noise Files
During batch file conversion, Kaleidoscope can analyze each output file looking for 
biological activity of interest and removing files containing only uninteresting signals 
such as ambient background noise, rain and wind, or unwanted biological signals such 
as insects when trying to record bats. 

Kaleidoscope looks for syllables of smooth continuous narrowband frequency sweeps 
characteristic of many forms of wildlife including bats, birds, and marine mammals. Even 
broadband vocalizations may contain dominant harmonics that could be described this 
way. 

On the "Filter" tab of the main Kaleidoscope window, there are several parameters used 
to describe the signal of interest. As files are processed, Kaleidoscope decides if the file 
meets the criterion specified: 

1. Check "Filter noise files" to enable filtering. Otherwise filtering will not be 
performed and all output files will be created regardless of content. 

2. Check "Keep noise files" if you wish to detect noise files but keep them around 
for manual inspection. If this is checked, a "NOISE" subfolder will be created and 
all of the files considered to be noise will be moved into the subfolder. Otherwise, 
the files will simply be erased from the outputs. 

3. Describe the "Signal of interest" by specifying a range of frequencies and 
durations of continuous smooth narrowband signals and a minimum number of 
such occurrences that must be found in a given file. If the criteria is not met, then 
the file is marked as noise and either discarded or moved to the "NOISE" 
subfolder as configured above. 

Useful tip: weak signals may cause a discontinuity in a detected syllable resulting in two 
or more smaller fragments. You may want to use smaller values for the minimum signal 
duration in order to consider these weaker signals as "interesting". 

The "Advanced signal enhancement" checkbox should generally be enabled and relates 
to conversion from full spectrum to zero crossing and for the auto classification of full 
spectrum recordings. 



Extracting GPS Tracks
During batch file conversion, the GPS track can be extracted from meta data found in 
the input files. To enable this feature, you can go to the "GPS" tab of the main 
Kaleidoscope window: 

Extract GPS Track 
If checked, the GPS information from input WAC and ZC files is used to 
generate a gps.csv or gps.kml file (according to the format). An entry is created 
for each trigger and, in addition, waypoints are created at the specified 
frequency. 

Format 
Specify CSV or KML format for gps information. In CSV format, columns are 
created for DATE, TIME, LAT, LON, and NAME where NAME is the filename of 
the corresponding output file or blank for waypoints. KML files can be opened 
directly from Google Earth and have a placemark corresponding to each output 
file plus a path of waypoints. 

Waypoint frequency 
Specify the frequency of waypoint output in seconds. 



Meta Data
Meta data are bits of information embedded in an audio files that might be useful in the 
interpretation of the recordings. For example, meta data might describe the location, 
habitat, weather, and deployment details for a given recording session. 

Kaleidoscope enables the use of meta data embedded in audio files. For .wav files, 
Wildlife Acoustics defines a proprietary extension in which to store meta data. For .??# 
files, there are a number of fields defined for this purpose. 

Kaleidoscope Meta Data

Kaleidoscope makes use of the following meta data fields: 

Voice note 
An embedded audio notation such as those created by the Echo Meter Touch. 
The icon button   will appear if a voice note is present, and clicking the button 
will play the voice note recording. 

Prefix 
The user-defined file prefix. 

Model 
The recorder model name. 

Timestamp 
The date and time a recording was made. 

GPS Location 
If a GPS receiver was attached to the recorder, the GPS coordinates 
corresponding to where the recording was made may be available. 

Notes 
Field notes created, edited and viewed by humans that could be used to 
describe the field and deployment conditions in great detail. 

Auto Identification Results 
The automatic identification made to species by Kaleidoscope 



Manual Identification Results 
The manually verified identification made to species by a human expert. 

Mapping AnalookW Meta Data to Kaleidoscope

For .??# files manipulated by AnalookW software, there are several meta data fields 
mapped to and from Kaleidoscope meta data fields as follows: 

AnalookW 
Meta Data

Kaleidoscope 
Meta Data

Additional Comments

Tape Notes A line in the Notes field that begins with "Tape: "

Loc Notes A line in the Notes field that begins with "Location: "

Spec Notes A line in the Notes field that begins with "Spec: "

Notes Notes Additional lines in the Notes field

Filetime Timestamp

Lat, Lon GPS Location

Species

Automatic 
Identification 
Results and 
Manual 
Identification 
Results

The "Species" field in AnalookW is formatted as 
"AUTOID (Kaleidoscope AUTOID,STATS)" or "MANUALID 
!(Kaleidoscope AUTOID,STATS)" where AUTOID is the 
automatic classification, MANUALID is the manually 
verified classification, and STATS are Kaleidoscope 
statistics.

Adding Field Notes to Output Files

During batch file conversion, Kaleidoscope can replace, append, or prepend field notes 
to the meta data in output files. On the "Batch" tab of the main Kaleidoscope window at 
the bottom of the "INPUTS" section on the left, you can select from among "Append 
notes to output meta data", "Prepend notes to output meta data" or "Replace notes in 
output meta data" and optionally type field notes into the text box below this choice. 
When you run the batch job, any notes provided will be added to any existing notes 
(depending on the choice specified) and written to the output files. Note that the 
original input files are not modified during batch processing. When outputting to .??# 
files, lines beginning with "Tape: ", "Location: " and "Spec: " are treated specially with the 
remainder of the line written to and replacing the corresponding AnalookW fields. 



Automatic Identification
You must have a Kaleidoscope Pro license to use the automatic identification feature. 
Wildlife Acoustics is building classifiers capable of fast and accurate identification to 
species. At this time, classifiers are offered for bats of North America and the United 
Kingdom. Not all species are covered, and while our accuracy rates are impressive given 
the technical challenge, you should not rely solely on automatic classification results to 
draw conclusions. Our objective is to give you a tool to efficiently analyze a large 
quantity of data in a short period of time. Wildlife Acoustics hopes to continue 
expanding classification coverage to include other animals and geographic regions and 
to improve accuracy. 

During batch file conversion, Kaleidoscope can apply classifiers to attempt automatic 
species identification at the output file level. In fact, it is not necessary to specify any 
output files in the batch process, but it is recommended to do so for efficient manual 
review and use of metadata. 

To enable automatic classification, go to the "Classifiers" tab on the main Kaleidoscope 
window, choose your classifier and desired sensitivity level. For best results, choose only 
those species you expect to find during your deployment. 

More information about individual classifiers can be found by clicking on the "About" 
button shown when you select a classifier. 

At the end of batch processing, an "idsummary.csv" and an "id.csv" file will be created at 
the top of the output directory. A results window containing some of the "id.csv" 
columns and the Kaleidoscope Viewer will be launched automatically so you can quickly 
review and update the auto classification results. The spreadsheet table can be saved 
after editing with "File->Save" or "File->Save As..". You can also re-open this view with 
Kaleidoscope Viewer from the main Kaleidoscope window with "File->Load results..." to 
continue work where you left off. 

Output Summary File (idsummary.csv)

The "idsummary.csv" file contains an overall summary of the batch classification. At a 
high level, this file is organized into rows representing output folders (from the input 
directory hierarchy) and columns representing species-specific data. More specifically, 
the first N columns represent the output directory structure hierarchy, where N is the 
maximum folder depth encountered. For example, if the input folder contained three 



subfolders A, B, and C, and each of these contained an additional three subfolders X,Y, 
and Z, we would have a total of 13 possible folder locations. This includes the root of 
the folder hierarchy, each of the three top level folders, and 9 additional subfolders 
including A/X, A/Y, A/Z, B/X, B/Y, B/Z, C/X,/C/Y and C/Z. The maximum folder depth in 
this example is two, so the first column represents the first level subdirectories and the 
second column represents the second level subdirectories. Asterisks are used to denote 
all the subfolders at a given level. So in this example, we would have the following rows 
and the first two columns: 

Column 1 Column 2 Comments

* * Represents overall totals

A * Represents totals for folder A and all its subfolders

A X Represents totals for files in A/X

A Y Represents totals for files in A/Y

A Z Represents totals for files in A/Z

B * Represents totals for folder B and all its subfolders

B X Represents totals for files in B/X

B Y Represents totals for files in B/Y

B Z Represents totals for files in B/Z

C * Represents totals for folder C and all its subfolders

C X Represents totals for files in C/X

C Y Represents totals for files in C/Y

C Z Represents totals for files in C/Z

For each species detected, there is an additional column indicating the number of files 
found matching the species. There is also a column for "NOID", meaning files that the 
classifier chose not to classify, and a column for "NOISE", meaning files that were 
unlikely to be bats. After these columns there is another set of columns for each species 
detected indicating the calculated presence P-values based on a Maximum Likelihood 
Estimator (Britzke 2002). 

Output Identification File (id.csv)

The "id.csv" file has a row for each output file (excluding "noise" files but including "no 
identification" files). The columns are as follows: 



FOLDER 
Directory path to the input file relative to the input root 

IN FILE 
Input file name 

CHANNEL 
Channel number from the input file (0=left, 1=right) 

OFFSET 
Offset in seconds into the input file where output begins 

DURATION 
Duration in seconds of the output file 

OUT FILE 
Name of the output file, excluding file type extension. 

DATE

Date in form YYYY-MM-DD of the recording 

TIME 
Time in form of hh:mm:ss of the recording 

HOUR 
Hour of the recording (0-23) for convenient pivot tables by hour 

DATE-12 
Date 12 hours prior to date of recording (e.g. for night vs. day) in the form 
YYYY-MM-DD 

TIME-12 
Time 12 hours prior to time of recording (e.g. for night vs. day) in the form 
hh:mm:ss 

HOUR-12 
Hour 12 hours prior to time of recording (e.g. for night vs. day) 



AUTO ID 
Automatic classification result 

PULSES 
Number of pulses detected in the file 

MATCHING 
Number of pulses matching the auto classification result 

MARGIN 
Classification margin - this is an uncalibrated confidence score and should not 
be subject to much interpretation other than that within a given species, higher 
values are more confident than lower values. 

FILES 
The number 1, indicating one file, as a convenience for pivot tables by file count 

MANUAL ID 
Manual identification (this field populated during review with Kaleidoscope 
Viewer 

Note that this .csv file format is designed for easy import into spreadsheet software to 
create pivot tables. You can for example create pivot tables to summarize 
species-specific activity by site, by day, by night, or by hour. 


